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Overview

Ocean Climate Station (OCS) buoys are deployed in high-latitudes. To survive the harsher
conditions, these buoys are built around a robust buoy platform consisting of a 2.5 meter
diameter discus buoy with a stainless steel frame and fiberglass well.

The buoys are heavily instrumented and typically include redundant meteorological systems —
ATLAS and FLEX. A typical suite of meteorological sensors includes:

ATLAS Tube FLEX System
* Gill sonic anemometer * Gill sonic anemometer (in a custom EDD
* Eppley long and short wave radiometers housing with Sparton compass)
(LWR/SWR) * Eppley long and short wave radiometers
* Rotronics air temperature and relative (LWR/SWR)
humidity (AT/RH) * Rotronics AT/RH sensor
* RM Young rain gauge * RM Young rain gauge

* Paroscientific or Druck barometer
¢ Vaisala WXT520 combo weather sensor
(test instrument, not primary)

The FLEX system also has hardwired communications through the top section cable to a 3PS
load cell at the base of the bridle, a SeaBird MicroCat (SBE-37) for SST/SSC, and an ATLAS SSC
module. Other subsurface instruments communicate inductively through the nilspin cable and
top section, allowing the FLEX to receive hourly samples from these sensors. The type and
placement of the instruments can vary depending on deployment location, but may include
SBE37, SBE39, SBE51, Nortek Aquadopp, Sontek Argonaut and RDI DVS.

FLEX transmits data via Iridium at a user specified interval. The current sampling scheme
samples all surface instruments, including the hardwired load cell and MicroCat, every 10
minutes. The inductive sensors are sampled every hour. Surface sensors are then averaged
into hourly values (from [hh-1]:30 to hh:30), while the inductive sensors are polled at 6 mins
after the hour and get the most recent value (burst values) from the top of the hour. Hourly
data are transmitted every 6 hours, usually about 30-40 minutes after the synoptic hours (00,
06, 12, 18z).

In addition to meteorological and oceanographic measurements, the OCS buoys typically
include a CO, system. With the inclusion of an additional sensor, such as pH, the buoys are also
considered “Ocean Acidification” buoys. OS Papa has had several additional instruments from
partners (UW — CTD/Gas Tension Device on bridle and 10 meters; OSU — Letllier fluorometers
and radiometers).

OCS moorings have been deployed as slack-line ‘reverse catenary’ mooring (such as KEO) and as
taught-line moorings (such as PAPA). The nylon and other line used for the majority of the
depth vary significantly depending on mooring design. Refer to the mooring diagrams for the
difference in design.
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Buoy Components and Shipping

If the OCS mooring is shipped in a container (i.e. to Japan), the discus buoy is shipped on the
aluminum buoy stand in order to fit into an 8’ wide container. The steel lifting bar (shown in
the photo below) is designed to lift the buoy at the same angle as the stand using two lifting
straps of the same length. If shipping on a flatbed (i.e. driving to Sidney, BC), a step-up flatbed
(or step-deck) has been used with adequate room for other equipment. In this case, the buoy
can be shipped with the bridle and load cell attached.

The aluminum towers used on the OCS buoys (shown below left) have two cable runs for
attaching wires, and the lower bars opposite the tea cup handle are removable to
accommodate the installation of the CO, equilibrator. Since the tower is aluminum, it must be
electrically isolated from the stainless steel buoy frame during assembly.

The bridles for the OCS buoys (shown below right) are stainless steel with removable lead
plates in the bottom. The bridles are made to accommodate a SeaBird MicroCat (SBE37), the
ATLAS SSC module, and (for Papa) tabs for mounting bars for UW CTD/GTD/02, and SAMI pH
sensors. The 3PS pancake style load cell has also been designed to fit on the OCS bridle.
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Some moorings have also
incorporated a bridle-mounted
RDI Workhorse Sentinel ADCP.
The ADCP is currently mounted
stand-alone, with no real time
data transmissions; however,
plans for interfacing the ADCP are
in the works.

The top sections for OCS moorings continue to be
developed and refined as the new subsurface
modem protocols are developed. PMEL has
opted to continue using a top section and
conductive nilspin wire rope for the subsurface
cable. The photo on the right shows a top
section similar to what was used for June 2008
PAPA, Sep 2008 KEO and subsequent
deployments. It incorporates the FLEX (SeaBird
IMM) subsurface connection and also a SBE37
hardwire connection for SST/SSC. The ATLAS
SST/C and any other additional sensors on the
bridle are connected through separate spiral wrapped cables.

The OCS mooring anchors have weighed between 6820 lbs and 8240 |bs at KEO, and 6850 |bs at
Papa. The anchors are typically cross-braced to ensure they stay together in high current areas
and to provide better control when deploying in rough weather.

Note the coated wire rope binder around the lower part of the anchor.
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Buoy Assembly

Instrument Well

The OCS buoys are shipped with the CO, electronics, and the CO; and Flex batteries, installed in
the buoy well with power disconnected. Due to concerns about the gas regulator and the
difficulty characterizing the buoy as a packaging for dangerous goods, the CO, reference gas
cylinder has not been shipped inside the buoy well. The Flex box is also shipped separately, and
installed on site. Upon arrival at the destination, inside the buoy well should be inspected for
damage, including the fiberglass mounts where the red frame attaches. In the past, one set of
mounts failed in cold weather because they were fiberglassed over a painted surface.

FLEX box

Alkaline
battery packs
underneath

CO2 span gas lid

It is generally a good idea to have a computer connected to the systems when connecting the
batteries. For these procedures, see the section on Logging Systems Start Up. Instructions for
assembling the CO, system are included in the CO, manual and will not be duplicated here. See
sections on leak checking the span gas cylinder (usually done at least 24 hours prior to
installation), checking the flow, installing and connecting the span gas, and running the air block
hoses through the bulkhead connector face plate. Work inside the buoy well is much easier
before the tower is installed; however, it can all be accomplished with the tower on if necessary.

The FLEX system is powered by three lithium battery packs inside the well. These are
connected in parallel via a y-cable that terminates in a round connector that plugs into the side
of the FLEX box. The FLEX box is connected to the faceplate via two 62-pin cables. A Watchdog
jumper inside the box will cause the FLEX system to drop into logging mode if no commands are
received within two minutes.

Once the systems inside the buoy well are installed and powered up, the lid can be closed and
sealed. It's important to note that when the buoy is on it’s side (with the bridle attached) rain
water can get into the well if only the four rubber latches are used; therefore the lid should be
bolted down at the earliest opportunity.
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Tower

If the buoy was shipped on the buoy stand, attach the buoy
lifting bar to top of the buoy with the lifting eye above the
buoy well, using two straps of the same length. This lifting
bar was specifically designed to pick up the buoy at the
same angle as the aluminum stand, to allow for easier
removal and attachment to the stand.

Preferably, set the P
buoy down flat. Do :

whatever work you can . ’. :
inside the buoy well, / 2 >
and then attach the
tower. Orient the
tower so that the top
section hole is 90 degrees from the tea cup handle, and
the removable lower bar is over the equilibrator hole.
Once picked up by the tea cup handle, this will leave the
CO, equilibrator hole near the bottom of the buoy and the
bulkhead connector faceplate pointing at a 45 degree
angle towards the ground.

— y

CO2 equilibrator

The tower installs on the right side of the buoy eyes (tabs) when looking towards the center of
the buoy. Use two flat micarta plates to sandwhich each of the aluminum tower pad eyes,
isolating the aluminum from the stainless steel buoy pad eyes. Also use the bolt isolators
(micarta or G10) inside the tower holes and apply anti-seize to the bolts. Refer to the Standard
Technique for Securing Buoy Tower and Bridle Bolts in the Appendix for torque specifications.

While attaching the tower, also attach the grounding lugs for all
systems. The grounding lug should be installed so that it is in
direct contact with the stainless steel pad eye of the buoy; the
stainless buoy frame then provides grounding to seawater. The
FLEX system should be grounded before the inductive loop is
established, or you risk damage to the load cell. Follow steps in
the Appendix for Verifying Faceplate Grounding.
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Bridle

Assuming the buoy and tower are sitting flat,
you can tie a line from the top ring of the
tower, opposite the tea cup handle, to a
forklift and slowly pull the buoy over. If a
second piece of lifting equipment is not -
available, a weight (such as the mooring
anchor) should be located close by and the
line run to that to hold the tower and buoy in
place while the bridle is lifted into place with
the forklift. Use boards to stabilize the buoy.
The buoy will initially want to tip to be
oriented with the two lower bridle pad eyes,
but as the buoy is tipped further over, it can
be spun to orient the handle up and the
appropriate bridle pad eye at the 12 o’clock
position. The bridle should be oriented so the v, Clamp for Radiator hose
“A2” cable clamp and the “radiator hose” Al : " a2

cable bracket line up under the top section E ‘ ALEN
thru hole as shown at right.

\-‘ﬁ4 . A 2 .
L - o~
‘ A2 cable clamp

Load Cell

The pancake load cell is usually attached to
the bridle before shipping. If the pancake
load cell is not attached to the bridle for
shipping, or it is necessary to swap out the
load cell, it can be installed either before or
after the bridle is attached, but it seems to be
easier without the bridle attached to the
buoy and the bridle sitting upside down on a
flat surface. In the picture, note the
orientation of the load cell for the cable run,
the micarta isolator plate, and double nutting
on the %” x 10 — 6” bolts. These bolts should
be torqued to 120 ft-lbs.

The load bearing yoke is oriented inside the load cell with two clevis blocks. If the clevis blocks
are not installed, the yoke can spin. On some load cells, there are two possible orientations of
the yoke — one of which is incorrect. The best way to check the correct alignment of the top
section and the load cell yoke is to attach the hardware (2 x 1 %4” shackles, 2 links of 1” chain,
and 1” shackle) and see how the top termination of the nilspin (the Bailey bracket) lays relative
to the lower connection of the top section. The yoke has a piece of rubber glued to the top of it
that gets squished between the micarta plate and the yoke to insure that it seats down into the
outer portion of the loadcell.
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Top Section

Once the main buoy assembly has been completed, the next step is to run the top section cable
through the buoy. This is done by passing a line through the top section hole from the top,
attaching it to the top section, and pulling the wires back through the buoy. The placement of
the top section is very important. The load cell wire and the SSC/SST cable are designed to not
have extra cable; and the orientation of the bottom socket of the top section needs to line up
with the top termination of the nilspin with some bow to allow buoy pivot. The top section has
a radiator hose over the outside of it to provide additional insulation where it is clamped to the
bridle. An A2 bridle clamp plate is used regardless of whether an ATLAS SSC is used. Check the
length of the cables before tightening down the clamps. PVC collars at the top and bottom of
the buoy provide additional place to panduit the top section.

The addition of the ATLAS SST/C and the SeaBird
SBE-37SMP Microcat requires a separate cable
be run along with the top section through the
buoy. This is preferably spiral wrapped or taped
to the top section for support. Before attaching
the load cell cable, lace the panduits (they don’t
need to be tightened down yet) through the
holes in the lower bridle; this is very difficult to
do once the cable is attached and the bridle
leads are installed.

Once the panduits are in and the load cell wire is
attached, you should double check the torque of
the load cell bolts and double nuts (120 ft-1bs),
and then install the seven bridle weights. The
leads are held in with a long stainless bolt, lock
washer, and square plate.
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Lifting

Depending upon lifting and transportation
equipment available, the buoy can be assembled
on the dock or aboard ship. If the buoy is
assembled on the dock or in a warehouse,
remember that it requires a sizeable forklift
(10,000 Ib capacity), rubber wheeled crane (such
as available at 10S) or a flatbed truck to transport
it to the ship. The assembled buoy weighs
approximately 2900 lbs (1300 Kg), but it is a very
bulky load and typically requires fork extenders
or boom. Lifting with a short strap on the tea
cup handle and a longer strap to the bridle
(shown at right) seems to provide good control of
the buoy. Alternatively, using a short (4’) strap
choked around the buoy tower pad eye on the
tea cup handle provides a good center of balance
without the bridle leads installed.

It is best to load the buoy without sensor masts
sticking up above the top ring of the tower.

Meteorological Sensors

ATLAS Tube

The ATLAS tubes are shipped in crates designed with a removable top to allow testing on deck
before the unit is installed in the buoy, if desired. Be sure the antenna is installed before
turning on the system, as the transmitter could be damaged without it. See the section on
Logging Systems Start Up for more information on '
beginning data acquisition.

It is easiest to install the ATLAS tube in the buoy
before installing any of the FLEX met sensors on
masts around the tower ring. Slide the tube into
place in the center of the tower. Align the notch
on the top edge of the tube with the buoy North,
as marked on the top shelf. If the shelf is not
marked, the buoy North is 90° clockwise from the
handle, when looking from the top. Bolt the tube
in place.
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ATLAS Gill Wind

An RTV silicone sealant is applied to the
ATLAS Gill to seal the sections of the
anemometer mount, including the screw
holes, to prevent water from entering the
lemo connector (between the tube mast and
the Gill). The transducer sections of the

Gill’s are also sealed to prevent water getting Seal with RTV
into the electronics. This should be done at silicone sealant
the lab before shipment, but should be

verified.

The Gill is attached to an extension sleeve,

which fits over the top of the tube mast and

is held in place by hose clamps. The North mark of the anemometer aligns opposite the
alignment notch in the mast. The mast will only bolt onto the ATLAS tube in one direction. This
mast also contains the transmit antenna and should always be installed while the tube is in
logging mode (with or without the Gill attached).

Instrument Masts

Unpack and install the meteorological sensors on their
respective masts. Attach the micarta mounting plates
to the buoy tower using a long 9/16” socket wrench.
Masts are mounted on the tower by placing the slots
in the base of the mast over the bolts in the micarta
plates and then rotating the mast into a locked
position, securing it with the nuts and lock washers.

FLEX Gill Wind

The Gill anemometers for FLEX are re-packaged onto a
custom base with an internal compass. This sensor is
mounted on a tall mast, to help get it above the clutter of
the other sensors, in hopes of improving the measurement
accuracy. A pigtail cable is run through the mast before it is
connected to the sensor. Sensor North should be aligned to
the buoy’s North mark as much as possible. This allows
easier interpretation of clutter effects or other possible noise
sources in the data during post processing

www.pmel.noaa.gov/ocs Page 9 February 2013



LWR/SWR

The two radiation sensors share a single mast. Be
sure to install them with the serial number stickers
facing the same direction. These stickers should
then face inward on the buoy. Pay careful attention
to the cable connections, making sure that the
sensors are connected to the correct pigtail. Shove
these connections up inside the mast tube before
mounting on the buoy, if possible.

Vaisala

The Vaisala combination sensor is re-packaged onto a
custom base, which contains a compass. Due to poor
data quality from most of the sensors, only the
barometer is used. The Vaisala is now bolted to the
middle shelf, at the same level as the primary
barometer (see below).

Rain

Install the plastic guard inside the funnel of the rain gauge to prevent solid
material from falling into the gauge. Add the bird spikes to the top and secure
with a hose clamp. Be sure to mount the gauge on the tower so that water
siphoning out the bottom will not drain onto any other sensors. Before
deployment, prime the rain gauge by pouring water into the top until it siphons
out the bottom, and then add approximately % cup more water to the top.

Barometer

There are two types of barometers used with the HLB buoys. The Druck (KEO) or the Paros
(PAPA). Barometers generally attach to one of the tower shelves with a micarta mounting plate
and through-bolts.
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AT/RH

The AT/RH sensors do not mount to masts. The
sensor mount is sandwiched between plastic
mounting plates and bolted in place on the side of the
buoy tower. Mount the sensor on the side away from
the tower step, for easier access to the tower ring if a
buoy ride is required.

Cable Routing

There are two cable channels in the buoy tower: one for ATLAS, and one for FLEX. Try to route
the cables as neatly as possible to these channels, avoiding sharp edges, kinks and areas where
a technician might step. Secure all cables with zip-tyes at regular intervals. Long cables will
need to be doubled back and fit neatly within the channels. It may be helpful to use electrical
tape to bind these coils before securing the entire bundle with the zip-tyes.

Subsurface Sensors

Programming

All subsurface sensors, including bridle instruments, must be turned on before installation.
Refer to the Quick Sheets in the Appendix for detailed programming instructions.

Mounting Bridle Instruments

At all deployment locations, an ATLAS SST/C module and an SBE37 are attached to the buoy
bridle. These mount using custom hardware to tabs welded on one bridle leg. Be sure to install
the poison pucks in the module. Part of the module mount also holds the top section in place
along the leg of the bridle.

Module Mounting . SBE37 Mbunting
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A Workhorse Sentinel ADCP is also mounted to the bridle in a steel can. The “kickstand” for this
must be installed at the same time as the load cell, and then the can slides into the ring on the
kickstand.

Kickstand for Sentinel ADCP Sentinel can mounted in kickstand

To assemble the Sentinel in the stainless can, there must be a piece of rubber in the bottom,
followed by a micarta plate. NOTE: In some versions, the micarta plate screws directly to the
instrument. Unscrewing the plate will open the pressure housing. Do not take this plate off in
a wet environment.

A thick ring of rubber sits on tip of the micarta plate, followed by two pieces of high-density
foam that encircle the instrument (or one piece of foam and one piece of PVC). A top plate

rests on top, followed by a thin rubber gasket, and all sandwiched in place by the top of the

stainless can. There is a cut-out in the plate so the serial connector can be accessed without
complete disassembly.

Science partners from other groups or institutions
often mount additional instruments on the bridle.
On the Papa buoys, there are special tabs welded to
the legs of the bridle, and custom clamps for the
instruments. The KEO bridles accommodate the
extra load with the use of PVC collars on the bridle
legs. Instruments clamp to these collars. As the
number of instruments on the bridle grows, it is
important to test fit and mark everything at the lab
before shipping. It is a very tight fit.

Partner sensors mounted on KEO bridle
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Testing Inductive Sensors

Sensors on the nilspin mooring cable send inductive signals through the wire, and communicate
with the FLEX electronics via the Top Section. The Top Section is run through the buoy as
described in a previous section. Before the nilspin is attached to the Top Section, the inductive
leads can be used to test the inductive sensors. Run a long section of test cable through the
instruments’ inductive coils. Connect one end of the test cable to an inductive lead of the Top
Section. The other end must be grounded to the buoy frame. This is best accomplished using
an alligator clip on the end of the cable. It may be necessary to grind the clip into the metal
slightly in order to get through the outer oxidized layer and achieve a good ground. The FLEX
box will then be able to communicate with the inductive sensors on the Ioop:_»

or

. J.- ~
g

After the nilspin is attached to the Top Section, the inductive leads will no longer be accessible
for testing. Testing of the inductive sensors can be accomplished by using a test cable with
alligator clips on both ends. Clip one end to the bottom of the nilspin, rout the cable through
all the instruments to be tested and then clip the other end to the stainless buoy frame to
complete the inductive loop. Refer to the IMM Communications portion of the Appendix for
further information on IM commes.

Installing Inductive Sensors

The subsurface sensors located in the top 50m of the cable are attached to the wire before the
buoy is deployed. Flake the cable out on the deck and install the sensors with the
measurement point at the depth mark on the wire (i.e. the probe of the SBE39 at the mark, or
the top of the current meter head at the mark). Check the instrument plan for the proper
instrument orientation. Some SBE39’s are deployed inverted in the top 15m, in order to shade
the probe and reduce artificially high temperature measurements caused by sunlight. Be sure
to install the current meters with their directional vane attached.

Logging Systems Start Up

Typically, the goal is to get all systems up and running to test data transmission before the ship
leaves the dock.

CO, System

The CO; system instructions are detailed in the manual, so those instruction will not be
duplicated here. Like most EDD designed systems, if the system is powered up without a
terminal attached it will go right into normal data logging mode. This is a failsafe so that if the
system looses power when deployed, it will keep logging data.
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For buoy setup purposes, it is recommended to have a terminal connected when powering up
the CO, system. Generally the “GPS” command, and the “XMIT” command will show you
whether comms are working correctly. Once that is verified, you can attach the air block and
equilibrator and start it in “FAST” mode with the equilibrator either in water (in the aquarium)
or in air — send an e-mail to Stacy to let her know which it is, and when you started the system.

FLEX

Before connecting the batteries, set up comms to the FLEX box in a terminal program with a log
file. FLEX startup behavior depends on the hardware configuration of the system. If the system
has an RF modem attached, and you want to use this
as your primary means of communication, then you
must power up the system with the red shorting
dummy plug in the FLEX comms connector at the face
plate. If no RF modem is attached, or if you prefer to
use direct communications, then you should power on
the system with a terminal attached. If the red plug is
not installed, or a terminal is not attached, the system
will start up and go into “NORMAL” logging mode by
default. Unlike other systems, FLEX does not have a
“DEPLOY” mode.

FLEX can be powered up with just ground wire attached, adding the sensors later; or you may
opt to connect at least all the meteorological sensors before powering up. Allowing the system
to sit at the FLEX> prompt draws the most power; logging modes better manage power drain,
so the system should be allowed to run.

It is best to check the system and sensor functionality before sealing the well lid. From your
terminal program, send the following commands (you may need to send “ctrl+c” a few times
first to establish comms):

GPS [Get a position fix, set the date and time, test Iridium comms]
STATUS [Show the system status]
Verify that the correct cal file is loaded
XMIT [Send a data file to test comms & notify lab the system is powered up]

The following commands are used to display the data output from the specified sensor. Make
sure the values are reasonable, and then send “ctrl+c” to get back to the command prompt.

ATRH WIND

SWR RAIN

LWR SSTC

BP LOAD

TESTIND [Displays a list of data from all instruments on the inductive loop]

When you are satisfied that everything is working properly, send the “LOG” command to put
the system into logging mode. See the FLEX manual for a complete list of available commands
and setup procedures.
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ATLAS

Be sure the antenna/wind sensor is attached before starting the system. The transmitter could
be damaged if the antenna is not attached when it transmits. Connect the tube to a terminal
program with a log file. At the command prompt, send the following commands:
STATUS [Shows the tube status and IC configuration]
CONFIG? [Shows current settings and allows the option of configuring the tube]
If the date or time is incorrect, is can be set here or by typing:
DATE = mm dd yyyy
TIME = hh mm ss
CONFIG.SENSORS [Configure modules. To delete an address, type “U” for unconfigured]
DEP [Starts deployment mode: 12hrs of fast sampling, then daily averages]
Disconnect the cable and switch to Telonics/Tweezers (described below) to monitor system
function and data output.

Remote Communications

Antennae Mounting

Two antennae are needed to communicate with the various buoy systems: the Telonics uplink
receiver and antenna are needed to listen to the ATLAS tube, and an RF antenna and modem

used for two-way comms with FLEX. These antennae should be mounted on the ship’s rail with
clear line of site to a deployed buoy. The cables are routed to the computers in the work area.

Telonics — Argos antenna Flex — RF antenna

In addition, an Iridium modem box is sometimes provided to have two-way comms with the
CO, system after deployment. Both the FLEX system and CO; systems can also be called from
shore via their Iridium modems. The functions that can be performed via Iridium are system
dependent and limited versus what can be done with hardwired or RF comms; for instance, a
new calibration file cannot be uploaded to FLEX via the Iridium link, but it can be done through
the RF modem.

Other antennae may include an Iridium antenna for better reception on the satellite phone and
a GPS antenna. This can be useful for monitoring the ship’s position, and also to accurately
know the time. Various software programs can be used with the GPS stream.
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RF Modem

The inside end of the RF antenna cable (RPSMA(M) — RG58 — N(M)) is attached to the RF
modem (DIGI, X-tend PKG 900mHz USB modem — below left). Alternatively, the RF modem has
its own small antenna (below right) that has decent range for talking to the buoy while on deck.
The external antenna setup should be used to enable better range after deployment.

The modem is hooked up to the laptop using a USB cable. The X-CTU software needs to be
installed on the computer in order to change the modem configurations and test the modem;
however, once modem is configured, TeraTerm presents a better display (scrollable, adjustable
screen width, can create a log file) than the X-CTU software. The FLEX manual has a detailed
section (Section 8) on setting up and using the RF modem.

Note: Some laptops assign USB to Serial connections Com Port numbers higher than 4;
TeraTerm does not appear to allow connections to Com 5 or higher. In these instances, Proterm
or Hyperterminal may be preferred. Alternatively, the Com port number can be reassigned in the
advanced settings of Control Panels = System > Hardware 2 Ports. Since Com port numbers
are assigned sequentially as additional items are connected, it is best to restart the computer
immediately before connecting the USB to Serial connector so that it is assigned the lowest
possible Com port number.

The length of time which the RF modem remains on is settable by the user. Thereis a
continuous mode and a remote wakeup mode; these modes and the settings to change the
local modem from one mode to the other are described in the FLEX manual, section 8.
Typically, the continuous mode will be on for 12-24 hours, or as long as the ship will be in range
to monitor the buoy after deployment. After that, the modem remains in remote wakeup
mode throughout the deployment OR until a laptop is connected through the comm terminal.

For additional information about using the RF modem to communicate with the buoy, refer to
the Quick Sheet in the Appendix.
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Telonics / Tweezers

The “old style” Telonics receiver is preferred as being easier to use and more reliable. Be sure
the receiver is in Diagnostic / All mode, shown as “DA” in the upper right corner of the screen.

Connect the Telonics receiver to the laptop and open Tweezers. From the File menu, “Start a
New Cruise.”

1. Once the Start New Cruise dialog is displayed, click on the Cruise Name box and enter

your desired Cruise Name (e.g. KEO10).

2. Name the .PAR and .LOG files as well. These can be the same (preferred) or different
from the cruise name.
Click the Load Cruise Disk button. The Select Source for Cruise Disk dialog appears.
Select the source or directory containing your cruise info and cal files to be loaded.
Your buoy PTT numbers should now be available at the Select Buoy button.
Use the Buoy Setup View to examine all parameters, ensuring data outputs make sense.

o vk Ww

If you need to deploy one of the spare sensors, go to the “View” menu in the tool bar and turn
on “Buoy Settings.” A list of the sensors will appear. Simply click on the one to be swapped. A
new window will open, showing the available sensors of that type. Select the one to be used
and click OK.

Recovery

Download Data

Once the buoy is recovered and secure on deck, the first thing to do is to download data from
the ATLAS tube and Flex box. Refer to the Quick Sheets in the Appendix for download
procedures. While data are being transferred, the tower instruments can be removed.

Buoy Breakdown

Once the data logging systems have been shut down, the buoy can be disassembled. Simply
reverse the steps described in the assembly procedures above. FLEX and CO, batteries are left
inside the well for shipping. Subsurface sensors should be turned off, and data downloaded if
time allows, as described in the Quick Sheets in the Appendix.

www.pmel.noaa.gov/ocs Page 17 February 2013



Appendix A: Quick Sheets

Verifying Faceplate Grounding

If the faceplate grounds are not properly connected, certain sensors can be damaged, including
the load cell. Verify these ground connections once the faceplate has been installed in the buoy
and connected to a FLEX box.

Set a multimeter to detect continuity. One of the leads must be small enough to be inserted in
a SubConn connector socket. | use a clip lead with a paper clip.

Touch one lead to the ground lug or buoy tab. With the other lead, check for continuity on the
following pins at the faceplate:

Term: Pin1l
Wind: Pin5
Load: Pin5
Rain: Pins 1,6

NOTE: If the faceplate is not connected to a powered FLEX box, only Load pin 5 and Rain pin 6
will have continuity with ground.
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RF Communications with FLEX

When setting up the shipboard (local) modem, it is easiest to start in X-CTU.

* Go to the “Modem Configuration” tab.

* Choose “Read.” The terminal window will display the current modem settings.

* Change the Destination Address (DT) to match the RF address of the buoy. The buoy’s
RF address can be found at the beginning of the STATUS reply.

* Set the Source Address (MY) to FFFF.

e SetlHtoCO

* Set HT to 60. This puts the local modem in wakeup mode and is only necessary if the
buoy modem has dropped out of continuous mode.

* Choose “Write” to send the new settings to the local modem.

Open a terminal program to communicate with the buoy.

* Be sure to choose the comm port for the USB.

* Press “Enter” to send a wakeup signal to the buoy modem. It may take up to 18 seconds
to get a response.

* Send any of the hot key commands to communicate with FLEX without dropping out of
LOG mode. These commands can be found in Section 6.1.6 of the FLEX Software
Manual.

* Send “ctrl+c” to drop out of LOG mode. The buoy modem will go into continuous mode
while the system is at the FLEX> prompt.

* |f the buoy modem is in continuous mode, it is best to change the local modem to
continuous mode as well.

o Inthe terminal program, turn on local echo and CRLF

o +++ Enters the command mode for the local RF modem

o ATHTFFFF Sets the mode to continuous (For wakeup, use ATHT60)
o ATHT Verifies the setting

o ATCN Exits command mode

o Turn off local echo and CRLF

The RF modem in the buoy (remote) is automatically configured in the firmware. It is best not
to attempt to change any of these settings, other than the address. The buoy modem will be in
continuous mode for 1hr after the start of logging, or when the system is at the FLEX> prompt,
therefore it is not necessary to put the local modem in wakeup mode. Fast data samples will
automatically transmit every 5min for the first 12hrs of logging, and the entire Iridium buffer
will also transmit via RF for the first 168hrs.

To change the address of the RF modem in the Flex box:
* Using the serial cable, set the RF address in the Config dialog
* Disconnect the serial cable and install the red jumper
* Cycle power on the box (this runs the RFINIT command and applies the new address)
* Set the local modem to the new address and verify comms

www.pmel.noaa.gov/ocs Page 19 February 2013



FLEX Data Download

Once the buoy has been recovered, the 10min data from the met sensors can be downloaded.

1.
2.
3.

0 N,

9.

Connect a computer to the terminal port in the face plate.
Stop logging by typing “ctrl + ¢” in a terminal program.
Record the clock error by sending the “st” command. Note the exact GMT time at the
moment you press return and compare it to the time returned in the FLEX status
message.
Send the “read” command.

a. The FLEX will ask to increase its baud rate.

b. The computer baud rate must be set to match, using the terminal settings.
FLEX will prepare to send a data file and displays prompts on screen.
From the File menu, choose, “Transfer,” “Xmodem,” “Receive.”
Set the directory path and file name.
Be sure to check the “1k” box at the bottom of the window. Leave the “Binary” box
checked.
Be sure the computer does not go into sleep mode during the file transfer.

10. When file transfer is complete, reset the computer baud rate to 9600.

When data transfer is complete, disconnect the batteries inside the well to prevent the system
from dropping back into logging mode.
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Downloading Data Using a Mac with ZTerm

The Mac to be used must have the ZTerm program, as well as a USB — Serial converter and its
driver installed.

Setup ZTerm with the following settings:
* Settings> Connection: 9600 baud, 8 data bits, no parity, 1 stop bit, Xon/Xoff checked
* Settings> Modem: from the popup menu, use either USA19H62P or KeySeriall

To download data from an ATLAS tube:
* Send “ctrl + ¢” once or twice, until an A2> prompt appears.
¢ System will now be in standby mode, no longer logging, and will not automatically drop
into a logging mode.
* With your watch handy, type TIME in the ZTerm window. Record the actual GMT time
at the instant you press return, and the time displayed on the screen as a result of the
TIME command.
* Before you start a download, use the Transfer Convert item under the File menu and
select Binary Data. (For FLEX downloads, leave as Text.)
* Type READ.DATA
o Note the number of records and total bytes.
o Type “Y” to the question “Download Data?“
o Atlas will ask to go to 115.2Kbaud. Press "Y”.
o From the Settings menu, got to Connection item and select 115,200 baud.
o Back in the terminal window, press the return key once. The tube will say “Start
1K Xmodem reception now.”
Use the File menu to select the “Receive Xmodem”. The download will start.
o When the download is complete, you will be asked to name the file. Use
“Tube###.BIN”
* Use the Settings menu, Connection item, to return the computer to 9600 baud. Click on
the OK button to close this settings window.

O

To download data from a SeaBird
* Use Zterm at 9600 baud
* Type “ds” to establish comms and check the clock error.
* Type “stop” to turn off logging and the pump.
* You can either type “gs” to finish and put the instrument to sleep, or continue with
downloading data if time allows.
o From the File menu, choose “Start Capture.”
o Inthe pop-up window, name the file “ARC_SBE37SMP_5851,” and select where
you want to save the file, then click, “Save.”
o Type “dd” in the terminal window. All records should start streaming on the
screen, being captured to the text file you created.
o When download is complete, go back to the File menu and click “Stop Capture.”
o Type "gs" to put the instrument to sleep.
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ATLAS Data Download

RECORDING CLOCK ERROR

When you first connect to the tube upon recovery, it is important to record any drift of the
internal clock. This information is recorded in the recovery logs and used in post processing.
Type “TIME” in the terminal window and note the GMT time at the instant you press return.
Compare the actual time to the time returned by the ATLAS tube.

STARTING THE DATA DUMP
The xmodem dump should be done on a laptop with a terminal emulation program set to 9600
baud, 8, N, 1, NO flow control.

1. Enter the command READ.DATA.
The tube will respond with the XMODEM sign on and ask if the current amount of data in
the tube is to be dumped. Type “Y” to proceed to determining the dump baud rate. A no
will give the user the option of dumping the entire 4 megs of onboard flash. A yes to this
will proceed to determining the dump baud rate. A no will abort the dump procedure.
There are no timeouts on these questions. To abort any data dump, answer no to both
questions. When a specific amount of data is selected to dump, the number of xmodem
blocks it will take is shown.

2. Determine the dump baud rate.
The user will next be asked whether or not to go to 115.2 kbaud. This question has no
timeout limit. If an N is the answer to the question, the baud rate will stay at 9600 baud,
and will ask for the user to start the transfer protocol. If a Y is the answer, the user will be
instructed to change to 115.2 kbaud, and enter a CR when ready. The user has 1 minute to
change the baud rate if this is selected. Use the terminal settings to change the baud rate.

3.  Starting Xmodem protocol.
Once the baud rate is established, the tube requests the start of the xmodem protocol.
The user has another 60 seconds to do this. A timeout will cause the dump to be
aborted. Also, at this point the user can abort the xmodem protocol by entering ctrl + x.

To start xmodem in TeraTerm, go to File > Transfer > Xmodem > Receive. At the pop-up
window, the user must select a directory path and filename for the data file. Also, BE
SURE TO SELECT THE 1K OPTION BUTTON AT THE BOTTOM OF THE WINDOW. The binary
box should remain checked. When the protocol is successfully started, TeraTerm will
open its xmodem window, and should show an increasing number of blocks and bytes.

4, Dumping the data.
Once the xmodem window is active, the transfer can be tracked by comparing the number
of blocks sent versus the number required as shown earlier by the tube in Step 1. If the
user desires to abort the dump for some reason, use the cancel button on the Teraterm
xmodem window. If this is done, there may be some data flash-by on the screen, as the
transfer of a block is interrupted.

www.pmel.noaa.gov/ocs Page 22 February 2013



5.

During the dump.

Because of some peculiarities of Windows, there may be times during a transfer when the
data flow stops for 10 to 12 seconds, then resumes. These will show in the final status
information as retries. They do not necessarily compromise the quality of the data
transfer. See the section on transfer status information below.

The status information.
After the xmodem protocol is terminated, the tube shows some status information.
The transfer status can either be transfer complete, transfer cancelled, or timeout.

The transfer complete condition will only be shown if all the data has been transferred,
and the protocol is ended in a controlled fashion. This indicates the tube has sent all the
data and the end of file character to the laptop. There should not be any timeouts, but
there may be some retries.

The transfer cancelled condition indicates an unsuccessful data transfer. This could be
caused by the user using the cancel button or the *x command. The cancelled condition
can also be caused by unsuccessfully trying to transfer any block more than 8 times.

The timeout condition can be caused by the user failing to get the baud rate set or the
xmodem started in less that a minute. It can also be caused by handshake timeouts
occurring during the transmission.

At the end of the data dump, leave the tube at the A2> prompt. The transmit antenna can now
be safely removed.
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ATLAS SSTC Module

Open the module case and remove the outer sleeve. Connect the comms cable and start a log
file in a terminal program. Press the white reset button to wake up the module.

The modules only recognize commands in ALL CAPS and there must be a space after the = when
setting date and time.

Standard Setup Commands
DATE = mm dd yyyy

TIME = hh mm ss

STATUS

LOG

Once logging is initiated, the sensor will begin sampling at the next even interval of 10 minutes
and will take samples according to the time set by the INTERVAL = command.

Recovery
Dry the module before opening the case to connect the comm cable. In the terminal program,
type TIME and record the clock error. Recover the data as described below.

Downloading Data
XMODEM DATA RETRIEVAL

1. Enter the READ.DATA command. The module will show the amount of data it expects to
dump and inquire if this is okay.

2. Ifitis okay, enter Y. If not enter N and the module will give the option of dumping all the
storage space. If this is desired enter Y. Entering N to this will abort the dump process.

3. Assuming the correct amount of data space has been selected, the user has an option to
go to 115.2 kbaud. Enter Y to go to 115.2 kbaud or N to stay at 9600 baud for this
option. There is a 1 minute timeout to select the baud rate and establish comms with
the module. If this time limit is exceeded, the module will abort the dump and drop back
to 9600 baud.

4. Assuming comms are established at either 9600 baud or 115.2 kbaud, the user is
prompted to start xmodem. This process also has a 1 minute timeout. The user must
select the xmodem receive option and make sure that the 1K button is selected. Also,
the user must specify the directory and file name of the data to be dumped. Once this is
done the xmodem transfer window will appear.

5. Sit back and wait until the dump is completed
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SeaBird 19

On ships where no CTD is available, it may be possible to borrow an internally logging profiler
from one of the NOAA survey ships (RAINIER or FAIRWEATHER) to take on the cruise.

ST: Set date and time
IL: Initialize logging
QS: Quiescent state

From SeaTerm, if using the Upload button, cast numbering starts at 0.
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SeaBird 37SMP v3.0

A 3-pin SeaBird communication cable is required to communicate with the instrument. [Note:
This is no longer the standard plug for the SBE-37 and it must be requested when ordering.]
Plug the cable into the waterproof connector on the bottom end of the MicroCat.

NOTE: Prior to deployment, use a piece of wire to ensure that the air bleed hole at the top of
the conductivity cell is clear of debris.

Establish Comms

Use SeaTermV2 for instrument setup and data downloads.
From the “Instruments” menu, choose “G. SBE37 RS232”
In the window that opens, the program will automatically try to establish comms
(settings should be 9600-8-N-1)

Instrument Setup
In SeaTerm, click the “Capture” button to start a log file, and send the following commands:

DS [display status]

DateTime=mmddyyyyhhmmss [use current GMT date/time]

OutputExecutedTag=N [turn off XML "Executed" tag]

MinCondFreq=3000 [Hz, sets min cond to run pump]

OutputSal=Y [output salinity]

OutputSv=N [do not output sound velocity]

OutputFormat=3 [sets output string to alternate converted decimal
format, compatible with older instrument strings]

ReferencePressure=1 [deployed pressure in decibars; 1db = 1m]

SyncMode=N

Samplelnterval=600 [10 minutes]

TXRealtime=N

SL [send last sample; verify format is:
ttt.tttt,cc.ccccc,sss.555s,dd mmm yyyy,hh:mm:ss]

InitLogging [must repeat command to erase recorder memory]

StartDateTime=mmddyyyyhhmmss [set to even 10min interval, e.g. 01022009232000]

StartLater [DO NOT FORGET TO SEND THIS COMMAND]

DS [verify status matches sample below]

Qs [quit session to put instrument in low power mode]

Sample DS Output

S>DS

SBE37SM-RS232 v3.1 - 67360 SERIAL NO. 7090 12 May 2012 16:52:07
vMain = 7.37, vLith = 3.02

samplenumber = 0, free = 838860

not logging, waiting to start at 24 May 2012 12:00:00

sample interval = 600 seconds

data format = converted engineering alternate

output salinity

transmit real-time = no

www.pmel.noaa.gov/ocs Page 26 February 2013



sync mode = no
pump installed = yes, minimum conductivity frequency = 3000.0
reference pressure = 1.0 decibars

Data Download

Start comms using SeaTermV2 (v1.1 or newer) as above. Do not use SeaTerm v1.59.

Click the “Capture” button to start a log file, and send the following commands:
Stop [stop logging]
DS [display status and record clock error]
NOTE: When checking the status, note the exact GMT time when the command is sent.
In the command window, type “GMT was hh:mm:ss” to keep a record of the clock error.
The instrument will return an error that the command was not recognized.

Close the capture file (if the file is not closed, all uploaded data will be written to the file)

Send “BaudRate=115200"
Change the SeaTerm comm setting to 115200, and resend the command to confirm the setting

Click “Upload” in the menu bar
In the window that opens, name the file with the serial number and mooring ID, and
save in the desired location
In the Upload Data tab, select “Binary” and “All as a single file”
In the Header Form tab, select “Prompt for header information” from the drop down

Click Start
Enter the Deployment ID, serial number, and sensor depth in the header fields

This process creates three files - .hex, .xml, .xmlcon

The downloaded data files can be batch processed with the other SBE37’s, as described in the
“SBE37 Data Conversion” quick sheet.
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SBE37 Data Conversion

When all sensors are downloaded, the files can be converted in a batch process

Open SBEDataProcessing-Win32 (v7.21 or newer)
From the “Run” menu, select “1. Data conversion”

In the File Setup tab:
In the “Instrument Configuration file” field, click the “Select” button
Navigate to the location of the files that were just downloaded
Select one of the .xmlcon files (it doesn’t matter which)
Check the box to “Match instrument configuration to input file”
In the “Input files” field, click the “Select” button
Select ALL of the downloaded .hex files

In the Data Setup tab:
Check the "Process scan to end of file" box
Click the "Select Output Variables" button, and choose:
Conductivity [S/m]
Salinity, Practical [PSU]
Temperature [ITS-90, degC]
Time, Instrument [julian days]
Click the “Start Process” button to create .cnv files

When the process is finished, go back to the “Run” menu and select “14. ASCII Out”

In the File Setup tab:
In the “Input files” field, click the “Select” button
Navigate to the .cnv files that were created above and select all

In the Data Setup tab:
Check the box to “Output header file”
Check the box to “Output data file”
Click the “Time Conversion Formats” button
Choose “Julian days to mm/dd/yyyy hh:mm:ss”
Click the Output Variables button - Select All
Click the Start Process button

Save all files (.hex, .xml, .xmlcon, .cnv, .asc, .hdr) for the data processors
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IMM Communications

To use the IMM box, plug it into a computer comm port and run a terminal program. Loop a
piece of wire through the inductive coil of the test instrument and plug it into the 2 waterproof
connectors. Any piece of wire can be used as your inductive test loop, or multiple wires
connected together, as the required resistor is inside the box. Turn the switch on. Your terminal
program should be set for 9600-8-N-1. All IMM commands must be followed by both carriage
return AND line feed (CR/LF). You can do this manually by pressing ctrl-m ctrl-j after each line,
or you can set your terminal program to send CRLF when you press "enter". In the terminal
program, press any key, and an IMM> prompt should appear. You have now woken up, and are
talking to, the local IMM in the plastic box.

First you need to send the captureline command, or forcecaptureline, or fcl. This command
generates a carrier tone on the inductive loop which wakes up any other IMMs on it. You may
also need to send a wake up tone, swt. If there is only one instrument on the test loop, you
should be able to type id?, and the local IMM will output the inductive address (00-99) of the
test instrument on the loop. If this does not work, there is a problem with the instrument, or
loop. Try rearranging the loop of wire, check that the test instrument coil is snugly closed, and
that the instrument has power.

Once you have the address of the instrument, you can talk to its IMM with commands
beginning with Inn where nn is the address. You can talk to the instrument itself with
commands beginning with #nn. All those 3 characters do is deliver the following text to the
appropriate addressee. Some commands that are useful for the remote IMM are:

Inngethd [get hardware data (from the IMM)]

Inngetcd [get configuration data (from the IMM)]

Inngetsd [get software data (from the IMM)]

Innsetdeviceid=mm [set new inductive address to mm, from nn]

Innsendbreak [sends a hardware break to the connected electronics package]

If these commands work, you can talk to the IMM, and your inductive loop is working fine. The
# text is sent directly through the IMM to the instrument. So you can send most any command
you would use with a hardwired RS-232 connection.

If you get a message like the following:
IMM>fcl
<Error type='FAILED' msg="'Low Transmit Voltage - low battery or bad coupler'/>
<Error type='"POWER FAIL' msg='Transmit Voltage Vtx=1.3'/>

You probably have a low battery powering your local IMM.
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SeaBird 37IMP v3.0

The primary way to communicate with the SBE37IMP is via a SeaBird Inductive Modem Module
(see IMM quicksheet). For data downloads, use the internal data I/O cable. (Seabird PN 801836)

NOTE: Prior to deployment, use a piece of wire to ensure that the air bleed hole at the top of
the conductivity cell is clear of debris.

Establish Comms

Use SeaTermV2 for instrument setup and data downloads.
From the “Instruments” menu, choose “H. SBE37 IM”
In the window that opens, the program will automatically try to establish comms
(settings should be 9600-8-N-1)

Instrument Setup
In SeaTerm, click the “Capture” button to start a log file, and send the following commands:

FCL [capture the inductive line]

SWT [wake up the instrument]

ID? [get the instrument’s inductive address]
Program the instrument for deployment:

*ID=nn [set the inductive address to nn]

#nnDS [display status]

#nnDateTime=mmddyyyyhhmmss [use the current GMT date/time]

#nnOutputExecutedTag=N [turns off XML tags]

#nnOutputFormat=1 [sets date format to 01 Jan 2008]

#nnReferencePressure=ddd [deployed pressure in decibars; 1 db =1 m, do not

use when pressure sensor is present]

#nnSamplelnterval=600 [10 minutes]

#nnTXSampleNum=Y [Flex expects the sample number in data string]

#nnSL [send last sample; verify format is:

sssss, ttt.tttt,cc.ccccc,dd mmm yyyy,hh:mm:ss,n OR
sssss, ttt.tttt,cc.cccce,pppp.ppp,dd mmm yyyy,hh:mm:ss,n

#nnSampleNum=0 [must repeat command to erase recorder memory]
#nnStartDateTime=mmddyyyyhhmmss [start at even 10min interval, e.g. 232000]
#nnStartLater [DO NOT FORGET TO SEND THIS COMMAND]
#nnDS [verify status matches sample below]

#nnQS [quit session to put instrument in low power mode]

Sample DS Output

IMM>#05DS

<RemoteReply>SBE37-IM v3.1 - 67360 SERIAL NO. 6141 17 May 2012 17:07:51
vMain = 7.35, vLith = 3.01

samplenumber = 0, free = 838860

not logging, waiting to start at 24 May 2012 12:00:00

sample interval = 600 seconds

data format = converted engineering

compatible mode enabled
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transmit sample number

transmit sample HEX time

pump installed = yes, minimum conductivity frequency = 3000.0
reference pressure = 20.0 decibars

PC baud rate = 9600

Recovery

Logging can be stopped inductively using any terminal program. Start a capture file and send:
FCL
SWT
ID?
#nnSTOP [stop logging]
#nnDS [display status and record clock error]
NOTE: When checking the status, note the exact GMT time when the command is sent.
In the command window, type “GMT was hh:mm:ss” to keep a record of the clock error.
The instrument will return an error that the command was not recognized.

Close the capture file

Data Download

Remove the end cap and connect the internal data I/O cable. (Seabird PN 801836)
Start comms using SeaTermV2 (v1.1 or newer) as above. Do not use SeaTerm v1.59.
If logging was not stopped earlier, do so now by sending STOP and DS commands

Send “BaudRate=115200"
Change the SeaTerm comm setting to 115200, and resend the command to confirm the setting

Click “Upload” in the menu bar
In the window that opens, name the file with the serial number and mooring ID, and
save in the desired location
In the Upload Data tab, select “Binary” and “All as a single file”
In the Header Form tab, select “Prompt for header information” from the drop down
Click Start
Enter the Deployment ID, serial number, and sensor depth in the header fields
This process creates three files - .hex, .xml, .xmlcon

The downloaded data files can be batch processed with the other SBE37’s, as described in the
“SBE37 Data Conversion” quick sheet.
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SeaBird 39IM

To communicate with the SBE39, use either the IMM with test loop (in which case all
commands are preceded with #nn), or unscrew the housing from the sensor end and plug the
RS-232 cable into the connector near the batteries (9600-8-N-1).

Establish Comms
Use SeaTerm v1.59 for instrument setup and data downloads.
From the “File” menu, choose “SBE39IM” NOTE: Do not choose “SBE39” even if using
an internal comm cable
A configuration window will open with three tabs:
1. COM Settings
Select RS-232 (Full Duplex)
Choose the correct comm port
2. Upload Settings (this can be skipped during instrument setup)
Set “Upload Baud rate” to 115200
Choose “All as a single file”
Check “Upload data in binary format”
3. Header Information (this can be skipped during instrument setup)
Select “Prompt for header information”
Click OK when done
Click the “Connect” button to begin comms with the instrument

Instrument Setup
Instrument setup can be done using the IMM.
In SeaTerm, click the “Capture” button to start a log file and send the following commands:

FCL [capture the inductive line]

SWT [send a wake up tone to the instrument]

ID? [get the instrument's inductive address]
*ID=nn [set the instrument's inductive address to nn]
#nnDS [display status]
#nnDateTime=mmddyyyyhhmmss [use current GMT date/time]
#nnTXSampleNum=Y [send sample number with output data]
#nnFormat=1 [sets date format to 01 Jan 2008]
#nninterval=600 [10 minutes]

#nnGetlast [send last sample; verify format is:

sssss,ttt.tttt,dd mmm yyyy,hh:mm:ss,n OR
sssss, ttt.tttt,pppp.ppp,dd mmm yyyy,hh:mm:ss,n

#nnlnitLogging [must repeat command to erase recorder memory]
#nnStartDateTime=mmddyyyyhhmmss [set start time to an even 10min interval]
#nnStartLater [DO NOT FORGET TO SEND THIS COMMAND]
#nnDS [verify status matches sample below]

There is no sleep command for the 39s
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Sample DS Output

IMM>#01DS

<RemoteReply>SBE 39-IM V 1.05 SERIAL NO. 3283 26 Apr 2012 17:29:21
battery voltage = 6.9

not logging: waiting to start at 24 May 2012 12:00:00

sample interval = 600 seconds

samplenumber = 0, free = 599186

SBE 39-IM configuration = temperature only

transmit sample number

temperature = 19.06 deg C

Recovery

Logging can be stopped inductively using any terminal program. Start a capture file and send:
FCL
SWT
ID?
#nnSTOP [stop logging]
#nnDS [display status and record clock error]
NOTE: When checking the status, note the exact GMT time when the command is sent.
In the command window, type “GMT was hh:mm:ss” to keep a record of the clock error.
The instrument will return an error that the command was not recognized.

Close the capture file

Download Procedure
Open the sensor and connect the internal comm cable
Use SeaTerm v1.59 to establish comms as described above
Select SBE39IM (do not choose SBE39, or this will cause gaps in the recovered data)
If logging was not stopped earlier, do so now by sending STOP and DS commands

Click the “Upload” button in the toolbar

When prompted for Header Info, enter the Deployment ID, serial number, and sensor depth
Name the file in the form: PA004_SBE39 7089

Click the “Open” button to start the upload

The upload is finished when the S> prompt is displayed in the command window
The downloaded file is a .asc file (ASCIl format) which does not need to be converted
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SeaBird 51TC

The only way to communicate with the SBE51 is via an inductive loop. There is no internal
comm cable, and data cannot be uploaded by the user.

Establish Comms

The SBE51 is not supported by SeaTerm software. Use any terminal program at 9600-8-N-1,

with CR/LF turn on for transmit.

Instrument Setup

Once the IMM box is setup, start a log file in the terminal program and initiate communications

with the instrument:
FCL
SWT
ID?

Program the instrument for deployment:
*ID=nn
#nnGETSD
#nnGETCD
#nnDATETIME=mmddyyyyhhmmss
#nnSETSAMPLEDATAFORMAT=2
#nnSETREPLYFORMAT=1
#nnSETREFERENCEPRESSURE=ddd
#nnSETPUMPTIME=4
#nnSETSAMPLEINTERVAL=600
#nnGETLAST

#nnINITLOGGING

[capture the inductive line]
[wake up the instrument]
[get the instrument’s inductive address]

[set the inductive address to nn]

[get status data]

[get configuration data

[use current GMT date/time]

[ASCIl out, no XML]

[no XML]

[deployed pressure, in decibars; 1db = 1m]
[default pump on time 4 secs]

[10 minutes]

[send last sample; verify format is:

[must repeat command to erase recorder memory]

#nnSTARTDATETIME=mmddyyyyhhmmss [set start time to an even 10min interval]

#nnSTARTLATER
#nnGETSD
#nnGETCD

Sample GETSD Output
IMM>#01GETSD
<RemoteReply>StatusData:
DeviceType=SBE51
Version=CT
SerialNumber=05100001
DateTime=31 Jan 2008 03:23:37
Power:
MainBatteryVoltage=13.97
LithiumBatteryVoltage= 3.24
SampleMemorySummary:
SamplesStored=2761
SamplesFree=319877
AutonomousSampling=yes
EventSummary:
numEvents=7
BlueTooth=not enabled
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Sample GETCD Output
IMM>#01GETCD
<RemoteReply>ConfigurationData:
DeviceType=SBE51
Version=CT
SerialNumber=05100001
Settings:
Pressurelnstalled=no
SampleDataFormat=converted engineering
OutputSalinity=yes
ReplyFormat=plain text
Samplelnterval=600
PumpTime=4
MinCondFreq= 3000.0
BlueToothBaudRate=9600
CalibrationCoefficients:
ExternalTemperature:
CalDate=04-Aug-07
Coefficients:
AO=4.057787e-05
Al=2.617650e-04
A2=-1.229890e-06
A3=1.272208e-07
InternalTemperature:
CalDate=04-Aug-07
Coefficients:
A0=1.112302e-04
Al=2.452875e-04
A2=1.539607e-07
A3=9.181031e-08
Conductivity:
CalDate=04-Aug-07
Coefficients:
G=-1.002044e+00
H=1.449721e-01
=-1.553974e-05
J=2.077665e-05
PCOR=-9.570000e-08
TCOR=3.250000e-06
WBOTC=-5.477549%e-06
REFERENCE_PRESSURE=1.600000e+02

Recovery
Connect via IMM as described above, and send:
FCL
SWT
ID?
#nnSTOP [stop logging]
#nnGETSD [display status and record clock error]
NOTE: When checking the status, note the exact GMT time when the command is sent.
In the command window, type “GMT was hh:mm:ss” to keep a record of the clock error.
The instrument will return an error that the command was not recognized.

The instrument must be returned to Seabird for data download.
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AquaDopp Profiler

Connect to Sensor
* Use provided RS232 cable, with optional external power
* Open the AquaDopp software terminal and click “Connect” (I010I) button in the tool bar

Initial Setup
* From the “On-line” menu:
o Set Clock to GMT (It’s also best to set the computer clock to GMT)
o Select “Compass Calibration.” Follow directions and load results if the compass
has not yet been calibrated
* From the “Deployment” menu, select “Erase Recorder” to clear any old data in memory
* C(Click the “Configuration” button (not menu) in the tool bar
o Inthe Standard tab, set the battery type and deployment duration, then select
“Use Advanced Settings”
o Inthe Advanced tab, set the following parameters:
= Measurement interval = 600
= Average interval = 120
= Measurement load = Auto
= Blanking distance = 0.35
=  Compass update rate =1
=  Power level = High -
=  Speed of sound = Measured
= Salinity = 35
= Diagnostics interval = 720
= Diagnostics samples = 60
= Coordinate system = ENU
= Analog input 1= None
= Analoginput 2 = None
= Analog input power out = Disabled
=  File wrapping = Off
= Serial output = Off
o IntheIM tab, set the following parameters:
= Check the Enable box
= Set the proper ID number
=  Power level is depth dependent
= Data format = ASCII
* Click “Update” to send the configuration to the sensor

Deployment
* Click the “Start Recorder Deployment” button in the tool bar
* Set the start time in GMT (starting one minute before the hour, i.e. 23:59:00)
* Name the internal file to match the instrument serial number
* Click OK
* Choose to save the configuration file
* Ignore the IM test (gives error)
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* Verify the clock setting
* |gnore battery voltage warning
* Proceed with deployment

IMM Comms
* Connect the inductive loop and open TerraTerm
* From the Setup menu, open the Terminal box
o New Line Receive = CR + LF
o New Line Transmit = CR + LF
*  From the Control menu, choose “Send Break”
* |nthe terminal window, type “CapturelLine”
* Send the Flex command to get data liiSampleGetLast (ii is the sensor ID)
* Verify the data output

When installing the sensor on the wire, be sure to attach the directional vane.

Sample Log File Output

Deployment : KEO008

Current time : 9/24/2010 6:40:21 AM
Startat :9/24/2010 6:59:00 AM
Comment:

Measurement interval (s): 600
Average interval  (s): 120
Blanking distance (m):0.37
Measurementload (%): 4
Power level : HIGH-
Diagnostics interval(min) : 720
Diagnostics samples  : 60
Compass upd.rate (s):1
Coordinate System :ENU
Speed of sound (m/s): MEASURED
Salinity (ppt) : 35

Analog input 1 : NONE
Analog input 2 : NONE
Analog input power out :DISABLED
File wrapping : OFF

Serial output/TellTale :OFF
Assumed duration (days):30.0
Battery utilization (%) :23.0
Battery level (V):11.2
Recorder size (MB):9
Recorder free space (MB):8.968
Memory required (MB):0.2
Vertical vel. prec (cm/s) : 1.7
Horizon. vel. prec (cm/s) : 1.0

Instrument ID :AQD 6290
Head ID :ALD 4140
Firmware version :3.34
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Inductive modem : ENABLED

Device ID 151

Transmit power level : HIGH

Data format : ASCII

Coupler impedance : Test ignored

IMM configuration:

<HardwareData

DeviceType='SBE90554 IMM' SerialNumber='70000890">
<Manufacturer>Sea-Bird Electronics, Inc</Manufacturer>
<HardwareVersion>41420H.1</HardwareVersion>
<HardwareVersion>PCB Type 3, 10345B</HardwareVersion>
<MfgDate>2009-09-08</MfgDate>

<FirmwareVersion>IMM Ver 1.12</FirmwareVersion>
<FirmwareDate>Jun 15 2009</FirmwareDate>

<FirmwareLoader>MSP LOADER RS232 57.6K 2007-02-08</FirmwareLoader>
</HardwareData>

<StatusData DeviceType='SBE90554 IMM' SerialNumber='70000890'>
<HostID>Host ID not set</HostID>

<EventSummary numEvents='259"/>
<Power><TransmitVoltage>9.1</TransmitVoltage></Power>
<SampleDataSummary NumSamples='0' TotalLen='0' FreeMem='16384"/>
<HostFileSummary Len='784"' CRC='0xF889AB2A'/>
<LineStatus>BUSY</LineStatus>

</StatusData>

<ConfigurationData DeviceType='SBE90554 IMM' SerialNumber='70000890">
<Settings ConfigType="2'
DebugLevel="2'
BaudRate='9600'
HostID="Host ID not set'
GdataStr="GDATA'
HostPrompt="x'
ModemPrompt="IMM>'
DevicelD="51"
EnableHostFlagWakeup='0'
EnableHostFlagConfirm="'0’
EnableHostFlagTerm="0'
EnableSeriaIMMWakeup="1"
EnableHostPromptConfirm="0"
EnableHostServeOnPwrup="'0'
EnableAutoIMFlag="1"
EnablePrompt="1'
EnableHostWakeupCR="0'
EnableHostWakeupBreak='0'
EnableEcho="0'
EnableSignalDetector="1'
EnableToneDetect="'0’
EnableFullPwrTX="1"
EnableBackSpace="0'
EnableGDataToSample='0'
EnableStripHostEcho="0'
EnableBinaryData="'1"
SerialType="0’
TermToHost="'254'
TermFromHost="'254'
SerialBreakLen='5'
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MaxNumSamples="40'
GroupNumber='0'
THOSTO0="0"
THOST1='5'
THOST2="1000'
THOST3="12000'
THOST4="'500'
THOST5="5'
TMODEM2="'500'
TMODEM3="18000'
TMODEM4="100'
/>

</ConfigurationData>

Aquadopp Version 1.34 Beta4
Copyright (C) Nortek AS

Recovery

* Connect to the sensor as described above

* Click “Yes” in the pop-up window to stop data collection

* To check the clock error, go to the “Online” menu
o Select the “Set Clock” option while noting the correct time
o The instrument time will appear in the pop-up window

o Click “Cancel” to close the window without changing the instrument clock

Download Procedure

* Go to “Communication” > “Serial Port”

o Inthe Recorder/Upgrade baud rate box, select 115200
* C(Click the Recorder Data Retrieval button in the tool bar

* |nthe pop-up window, choose the file to be downloaded and click Retrieve

* Name the file and choose where to save the file [naming convention
“DepID_AQDP_SN##.aqd]

* Click Done to exit the pop-up window when all necessary files have been downloaded

¢ (Click the Data Conversion button in the tool bar

* Select “Add file”, choose the file you just downloaded and click the blue arrow

¢ Save all files
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RDI Workhorse Sentinel ADCP

Open a terminal program at 9600 baud and start a log file. Connect the instrument via the
serial cable. Use the external power supply if the battery power is low.

Standard Setup Commands
Send a break to the instrument

PSO [Display the instrument setup]

CR1 [Set parameters to factory defaults]

PA [Perform internal self checks]

PC1 [Beam continuity check. Follow instructions on screen.]

PC2 [Sensor check. Change instrument attitude to verify values change.]
CF11101 [Set communications flow control]

EAO [No heading alighnment offset]

EBxx [Magnetic variation in 1/100 degrees. PAPA is 1700, KEO is -500]
ED20 [Transducer depth in decimeters]

ES35 [Salinity]

EX11111 [Coordinate transformation]

Ez1111101 [Sensors installed]

RNXXXXX [Deployment name]

RE ErAsE [Erase internal recorder]

TSyymmddhhmmss [Set internal clock to GMT]
TE003000.00 [30min ensembles]

TP000100 [1sec ping rate]

TFyymmddhh5900 [Set time of first ping to start one minute before the hour]
WAS0 [Turn on the fish rejection algorithm]

WBO0 [Water profile bandwidth set wide]

WD111100000 [Data output settings]

WF176 [Blanking distance]

WNS80 [80 bins]

WP120 [120 pings per ensemble]

WS100 [Bin size in decimeters]

WV175 [Ambiguity velocity]

CK [Store new settings to memory]

C? [Verify comms settings]

E? [Verify environmental settings]

R? [Verify recorder settings] NOTE: Check the memory card size.
T? [Verify time settings]

W? [Verify water profile settings]

CS [Start pinging at specified start time]

Recovery

Connect to the instrument in a terminal program or WinSC. Send a break to stop pinging. Send
“T?” to check the clock error (TS field). There is no way to check battery voltage. Once pinging
has been stopped, the instrument will time-out and go to sleep if nothing else is done.
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Download Procedure
Using the WinSC software, either choose the “Recover data from an ADCP’s recorder” radio
button at startup, or go to File>Recover Recorder Data. Name the downloaded file

“SENT_SN##.pd0.”

Sample Setup File

[BREAK Wakeup A]

WorkHorse Broadband ADCP Version 50.40
Teledyne RD Instruments (c) 1996-2010
All Rights Reserved.

>PSo

Instrument S/N:
Frequency:
Configuration:
Match Layer:
Beam Angle:
Beam Pattern:
Orientation:
Sensor(s):

14605

307200 HZ

4 BEAM, JANUS

10

20 DEGREES

CONVEX

up

HEADING TILT 1 TILT 2 DEPTH TEMPERATURE

Pressure Sens Coefficients:

c3
c2
cl
Offset

Temp Sens Offset:

CPU Firmware:
Boot Code Ver:
DEMOD #1 Ver:
DEMOD #2 Ver:
PWRTIMG Ver:

+2.180916E-12
+5.302673E-08
+1.173393E-01
-4.440037E+00

0.06 degrees C

50.40 [0]

Required: 1.16
ad48, Type: 1f
ad48, Type: 1f
85d3, Type: 6

Actual: 1.16

Board Serial Number Data:

OB 00 00 06 907 BB 71 09 CPU727-2011-00E
D9 ©00 00 06 07 C8 B3 09 PI0727-3000-00G
7E 00 00 06 @7 D4 AB 09 REC727-1000-04E
20 00 00 06 07 E1 E7 09 DSP727-2001-04H

>CR1
[Parameters set to FACTORY defaults]
>PA

PRE-DEPLOYMENT TESTS

CPU TESTS:
RTC. . iiitiiieeeetieseceacescoscccanvnnns PASS
RAM. .. it iiiiieetienececcascoscocanvnnns PASS
ROM. i i i i i i ettt i PASS

RECORDER TESTS:

PC Card #0.....itietnneneeneeneeneannnns DETECTED
Card Detect....vviiiiiniinnenennnnnnns PASS
Communication.......coiiiiiiininnnnnnnns PASS
DOS Structure.....civiiiiiieinninnnnnans PASS
Sector Test (short)......ccvvvvivvnnnnn. PASS

PC Card #1....iuiiietneeneeneeneenennnnns NOT DETECTED

DSP TESTS:
L 1 1 = Y PASS
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Demod RAM.......cciiiiiiiinnennnennnnns PASS
Demod REG........ciiiiiiiiiiiennnennnnn. PASS

SYSTEM TESTS:
XILINX Interrupts... IRQ3 IRQ3 1IRQ3 ...PASS

Wide Bandwidth............ ..., PASS
Narrow Bandwidth............. ... .. ... PASS
[ I e T I o =] PASS
Transmit. ...ttt iineeennnnns PASS

SENSOR TESTS:
H/W Operation.......cciiiiiiiininnnnns FARREATLHF**

>PC1
BEAM CONTINUITY TEST
When prompted to do so, vigorously rub the selected beam's face.

If a beam does not PASS the test, send any character to the ADCP to automatically select the
next beam.

Collecting Statistical Data...

42 41 41 48 42 41 40 48 42 41 40 48 42 41 40 48 42 41 40 48 42 41 40
48 42 41 40 48 42 41 40 48 42 41 40 48 42 41 40 48 42 41 40 48 42 41 40
48 42 41 40 48 41 41 40 48 41 41 40 48 41 41 40 48 41 41 40 48 41 41 40
48 41 41 40 48 41 41 40 48 41 41 40 48

Rub Beam 1 = PASS
Rub Beam 2 = PASS
Rub Beam 3 = PASS
Rub Beam 4 = PASS
>PC2

Press any key to quit sensor display ...
All Sensors are Internal Only.

Heading  Pitch Roll Up/Down Attitude Temp Ambient Temp PRESSURE

49.10° -23.15" -23.97" Up 25.12°C 22.63°C 3.7 kPa 49.15 -23.15"
-23.97" Up 25.08°C 22.65°C 3.5 kPa 49.26° -23.15 -23.97" Up
25.11°C 22.63°C 3.4 kPa 49.12° -23.15" -23.97" Up 25.10°C

22.65°C 2.0 kPa 48.96° -23.15" -23.97" Up

>CF11101

>EAO

>EB1700

>ED20

>ES35

>EX11111

>EZ1111101

>RNPAGOS5

>RE ErAstE erasing...
Recorder erased.

>TS110518161950
>TE003000.00
>TP000100
>TF110604115900
>WA50

>WBO
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>WD111100000

>WF176

>WN80

>WP120

>WS100

>WV175

>CK

[Parameters saved as USER defaults]

>C?

CB = 411 ----------mnmmmm- Serial Port Control (Baud [4=9600]; Par; Stop)
CC = 000 000 00O --------- Choose External Devices (X;X;X X;X;X X;X;SBMC)
CF = 11101 --------------- Flow Ctrl (EnsCyc;PngCyc;Binry;Ser;Rec)

CK mmmmmmmm e Keep Parameters as USER Defaults

CP =0 -------mmmmmme - PolledMode (1=ON, ©=0FF; BREAK resets)

CR # ----mmmmmmmmmme - Retrieve Parameters (@ = USER, 1 = FACTORY)
CS —mmmmmmm e Go (Start Pinging)

CZ ------mmmmmmmm e - Power Down Instrument

>E?

EA = 400000 -------------- Heading Alignment (1/100 deg)

EB = 401700 -------------- Heading Bias (1/100 deg)

ED = 00020 --------------- Transducer Depth (@ - 65535 dm)

ES = 35 ----mmmmm e Salinity (©-40 pp thousand)

EX = 11111 --------------- Coord Transform (Xform:Type; Tilts; 3Bm; Map)
EZ = 1111101 ------------- Sensor Source (C;D;H;P;R;S;T)

>R?

Available Commands:

RE -------mmcmmmmmee e Recorder Erase

RF —mmmmmm i mmmme o Recorder Space used/free (bytes)

RN PA@O5 -------------- Set Deployment Name

RR ----mmmmmmmm - Recorder diRectory

RY -----mmmmmmmm - Upload Recorder Files to Host

R? ---mmmmmmmm - Display Recorder Commands

>T?

Available Commands

TB 00:00:00.00 --------- Time per Burst (hrs:min:sec.sec/100)

TC 00000 --------------- Ensembles Per Burst (0-65535)

TE 00:30:00.00 --------- Time per Ensemble (hrs:min:sec.sec/100)

TF 11/06/04,11:59:00 --- Time of First Ping (yr/mon/day,hour:min:sec)
TG 2011/06/04,11:59:00 - Time of First Ping (CCYY/MM/DD,hh:mm:ss)

TP 00:01.00 ------------ Time per Ping (min:sec.sec/100)

TS 11/05/18,16:27:09 --- Time Set (yr/mon/day,hour:min:sec)

TT 2011/05/18,16:27:09 - Time Set (CCYY/MM/DD,hh:mm:ss)

TX 00:00:00 ------------ Buffer Output Period: (hh:mm:ss)

T? - Display Time Help

SW?

Available Commands:

WD 111100000 ----------- Data Out (Vel;Cor;Amp PG;St;PO® P1;P2;P3)
WF 0176 ---------------- Blank After Transmit (cm)

WG 000 ----------------- Percent Good Minimum (1-100%)

WN 080 --------------u-- Number of depth cells (1-255)

WP 00120 --------------- Pings per Ensemble (©-16384)

WS 0100 ---------------- Depth Cell Size (cm)

WV 175 ----------------- Mode 1 Ambiguity Vel (cm/s radial)

WZ 010 ----------------- Mode 5 Ambiguity Velocity (cm/s radial)

W2 - - Display Water-Profile Help

>CS
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Appendix B: Assembly Check Sheets

CO2 System

As early as possible, install the regulator on the cylinder and do a 24hr leak test.

The following day, satisfied that there are no leaks, perform the flow test.

Install the cylinder in the buoy.

Set up the equilibrator and connect to system. Before running the system outside,
please make sure that the airblock is hooked up. The airblock provides a water block
preventing rain, water, whatever from getting pulled into the system. The equilibrator
does not need to be in the water to run the system.

Connect a computer to the face plate terminal, start a log file, connect the batteries.

At the command prompt, follow the manual instructions for "Powering and Comms with
System."

Notify CO2 personnel (Stacy via e-mail) that this has happened.

Put the equilibrator in the aquarium. Be sure to hook up the airblock before running the
system. To move the equilibrator into the aquarium, send Ctrl-C to stop the system.
XMIT the data back to the lab, then move the equilibrator into the aquarium. Finally
restart the system. Depending how much time you have, you may want to start with
the “fast” command so that Stacy can look at the data immediately.

Let the system run in normal or fast mode and contact CO2 personnel to let them know
it's in water.

At end of aquarium test, stop the system and XMIT data.

Remove the equilibrator from the aquarium and install it in the buoy, securing it up in
the tube.

Put the system in normal mode and let it run on deck until deployment day

About 4hrs before deployment, stop the system, XMIT, put in dep mode and lose data.
Notify CO2 personnel when the system goes into dep mode.

Notify CO2 personnel when the anchor is dropped and give an estimate of when you
think it will be settled.
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HLB Buoy Assembly

Buoy and Sensor Assembly:
* Begin CO, regulator leak check
Install load cell on bridle
o Include all isolators
o Double nut bolts
* Assemble buoy/tower/bridle
o Add grounding cables to tower
o Use isolators, micarta plates and anti-seize
* Unpack ATLAS tube
o Putsilicone sealant on ATLAS Gill
o Install Gill and transmit antenna on tube
* Start ATLAS tube in TeraTerm — Save to a log file
o STATUS
CONFIG?
DATE = mm dd yyyy
TIME = hh mm ss
DEP starts fast mode followed by normal logging — DO NOT put the tube into
logging without the transmit antenna mast installed
o Send e-mail to ATLASRT@noaa.gov to notify lab to monitor data
* |Install the ATLAS tube in the buoy
* Verify ops of ATLAS system via Tweezers/Telonics
o Telonics receiver set to Diag/All mode (DA)
o Follow “Start New Cruise” procedure in Tweezers and load cal file
* Unpack met sensors, mount on masts, install on buoy
o Run cables through cable runs but do not secure yet
* Install CO; Iridium antenna and light on tower
* Turn on subsurface instruments
o Verify logging parameters
o Reset clocks to GMT time
o Set start time
o Wake up Module
=  DATE= mm dd yyyy
=  TIME=hh mm ss
= LOG
* Install Top Section and bridle instruments
o Spiral wrap any additional cables
o Connect subsurface instruments via inductive test cable for testing
o Zip-tye load cell cable in place before adding weights
* Add weights to bridle

©)
©)
©)
©)

Work in the Well:
¢  Perform the CO, flow rate check
* Assemble CO, equilibrator, attach air block
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* Install FLEX box and CO; gas bottle in well, connect comms before batteries
* Start CO, aquarium test with system in FAST mode
o E-mail Stacy to notify of testing
* Install FLEX cal file via TeraTerm — Send ascii file
* Verify ops of FLEX system via TeraTerm — Save to a log file
o Follow FLEX box checkout checklist to test FLEX system
o E-mail ATLASRT@noaa.gov to notify lab to monitor data
* Secure cables inside well
* Replace desiccant, verify H2 getters
* Grease well lid before securing, then tighten all bolts
* Install RF plug in FLEX faceplate
* Verify FLEX RF comms using RF Comms Quick Sheet
* Route and secure cables once all system ops are verified

Final Steps:
* Stop CO, aquarium test
o XMIT
o Install equilibrator in buoy, securing float
* Mount RF, Telonics, Iridium and GPS antennas on ship, run cable to work area
* Re-verify FLEX and ATLAS systems ops via remote comms (within 12hrs of startup)
* Check all bolts and cable routing
* Attach nilspin, instruments and fairings
* Secure gear for sea

Deployment Day:
* Put all systems in Deploy modes no more than 4hrs pre drop
o ATLAS = DEP
o CO2=DEP
o FLEX=LOG
* Prime rain gauge — Pour water in until it drains, then add ~1/2c more
* E-mail ATLASRT@noaa.gov with deployment info

o Location
o Depth
o Time
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FLEX Box Checkout Checklist

Type command at prompt | |
Comms & Cal File STATUS Verify correct cal file is installed
Flex Box #: Firmware:
GPS GPS
System Actual
Date & Time DATE
TIME
Name Deployment CONFIG
S/N & RF address set to Flex Box #:
Project name (e.g. PAQ5S):
Platform set to Flex Box #:
Minutes for Iridium first call set to match Flex Box #:
Iridium Transmitter XMIT
Logic Transmit
Battery Voltages BATTS
Initialize Sensors INITALL
INITIMM
RFINIT
Met Sensors Verify reasonable data output
ATRH ATRH
Compass C100 or SPARTON
Wind WIND
BP BP
Rain RAIN
LWR LWR
SWR SWR
Vaisala ATRH ATRH2
Vaisala Compass C1002 or SPARTON2
Vaisala Wind WIND2
Vaisala BP BP2
Vaisala Rain RAIN2
Subsurface
Module SSTC
Load Cell LOAD
Inductive Sensors TESTIND
Confirm Status STATUS
Start Logging LOG Install red dummy plug in faceplate
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Appendix C: Design Development

PAPA

Since the June 2008 PAPA cruise, the FLEX system has become the primary data gathering and
transmission system including ‘driving’ the inductive cable for subsurface data collection using
the Seabird IMM protocol. Pre-deployment testing on deck of TULLY in February 2008 showed
reliable data; however, subsequent shallow water testing in Lake Washington revealed some
spurious data drops. The number of data dropouts was greatly reduced with the change of a
Seabird IMM setting in May 2008 — changing from high power to low power. The first full
ocean depth deployment of the Seabird IMM — FLEX setup went in the water at OS Papa in June
2008 from the TULLY. The system was plagued with resets early in the deployment, poor
communications from the DVS, and intermittent data from the Microcat SST/C. However, the
Seabird IMM instruments have been very reliable transmitting data in near real-time.

Once the DVS were disabled (FLEX told via iridium to stop looking for DVS data), the reset
problem was resolved. This led to the conclusion that the watchdog timer was set to be too
short, and since 3 of the 4 DVS were giving spurious data, the system was timing out or thought
it was hung up while waiting for DVS data and resetting. DVS problems were further
investigated by TRDI and PMEL and it was concluded that a previously applied firmware
upgrade had a glitch that resulted in very low transducer output resulting in poor/no data
return once deployed. The wakeup sequence for the DVS was also adjusted in updated
versions of the FLEX software. There were also problems with the DVS resetting during
deployment. The DVS clocks have been found to drift significantly, this drift could cause
problems with ensemble timing and inductive sampling.

As for the intermittent SST that ultimately failed, EDD testing showed that the SBE-37 Microcat
was not going back to sleep after being sampled due to some spurious characters after the
sleep command. In addition, the timing of the data request (polling) of the Microcat was
adjusted to avoid possible conflicts with sampling. Due to the power consumption issue, it was
decided to not connect the SBE-37SMP to FLEX (even disabled — commented out in cal file) on
KEO-2008 to avoid any possible power drain issues. For PAPA-2009 (PA003) the SST/C will only
be polled hourly by FLEX (like all other subsurface instruments) instead of every 10 mins like
other MET sensors. The sensor will still sample every 10 mins. In addition, the new Seabird
battery packs (12 AA lithium cells in a plastic case) provide more amp-hours than the old ones.

The nilspin on PA002 failed inside the top boot in Nov 2008 and all subsurface instrumentation
was lost; the surface mooring was recovered in Jan 2009. Due to the failure, the instrument
load on the upper portion of nilspin was greatly reduced on the June 2009 (PA003) mooring.

Another change after the PA0O2 wire failure was to shorten the nilspin wire length to 325m for
Papa since the deepest sensor is at 300m. This brings the swivel closer to the buoy and,
theoretically, allows the wire to spin more easily. Compass data inferred that the PA002
surface mooring rotated more that it’s counterpart at KEO possibly contributing to the failure.

www.pmel.noaa.gov/ocs Page 49 February 2013



It was expected that if the system was powered on with the red ‘shorting’ dummy plug installed
(indicating to use the RF modem), when the dummy plug was then removed and a terminal
attached, that the RF connection would continue to work. Testing during the February 2008
PAPA cruise showed that this was not the case; once the laptop terminal was plugged in, RF
comms are disabled and we were unable to re-establish comms using the RF modem even once
the red plug was put back in the connector. The only way we found to re-establish the RF link
was to open up the buoy well lid, and cycle power with the red plug in the FLEX comm port.
Some new options were subsequently added to the FLEX software (the <torf> command) to
allow switching back and forth between the RF modem and the hard-wired terminal. However,
this is not a hotkey command so logging must be stopped and it has to be done at the

FLEX> prompt. V1.08 incorporated some detection algorithms and swapping during logging is
now automatically detected.

Once the RF link was established, it was very robust and worked well. It provides all the
functionality of being directly connected to the buoy while sitting inside the lab. In addition,
with proper antenna placement, comms with the buoy at ranges over 2nm have been
accomplished.

KEO

Due to dragging of the KEO-2008 anchor, the KEO-2009 (KEOO7) anchor weight was increased to
8240 lbs (in air, 7325 lbs wet) requiring an extra wheel on both anchors and therefore different
cross bracing.
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Appendix E: Outdated & Unused Quicksheets

SeaBird 37SMP (Pre v3)

ALWAYS KEEP THE CONDUCTIVITY CELL WET WHEN LOGGING OR COMMUNICATING WITH THE
INSTRUMENT

The SeaBird MicroCAT (SBE-37SMP with Serial connection, Memory, and Pump) is the SST/C
instrument used by flex. It is cabled to the flex electronics through the "topsection" and is
queried just after the top of the hour for its last recorded value. These values are reported by
FLEX as an hourly reading.

SBE37 is run in the "Autonomous Logging" mode. In this mode, the pump will run whenever the
instrument samples. SeaBird pumps should not be run dry, so the cell must be filled with
absolutely clean water (sea or fresh), the vent hole covered, and the cell oriented upwards if it
is running. Another option is to have it collect a sample (in autonomous logging mode, or
perhaps with TS) then stop logging. This sample will then be sent to FLEX with every SL
command, so it will have (constant) data.

Note also that the pump runs for 0.5 seconds any time the you wake up the instrument. So
even during setup, or when FLEX queries it, it will run the pump, regardless of logging status

A 3-pin SeaBird communication cable is required to communicate with the instrument. Plug the
cable into the waterproof connector on the bottom end of the MicroCat. You should now be
able to talk to it at 9600-8-N-1.

Standard Setup Commands

DS [display status]

MMDDYY=mmddyy

HHMMSS=hhmmss

OUTPUTSAL=Y [output salinity]

OUTPUTSV=N [do not output sound velocity]
FORMAT=1 [sets date format to 01 Jan 2008]
REFPRESS=1 [deployed pressure in decibars; 1db = 1m]
SYNCMODE=N

NAVG=1 [take 1 sample to average]
PUMPINSTALLED=Y

INTERVAL=600 [10 minutes]

STORETIME=Y [store sample time with data]
TXREALTIME=N

SAMPLENUM=0

STARTMMDDDYY=mmddyy

STARTHHMMSS=hhmmss [start at even 10min intervals, e.g. 232000]
STARTLATER

DS
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Sample DS Output

S>ds

SBE37-SM V 2.6b SERIAL NO. 3802 31 Jan 2008 03:47:16
logging not started

sample interval = 600 seconds

samplenumber =0, free = 233016

do not transmit real-time data

output salinity with each sample

do not output sound velocity with each sample
store time with each sample

number of samples to average = 1

reference pressure = 1.0 db

serial sync mode disabled

wait time after serial sync sampling = 30 seconds
internal pump is installed

temperature = 4.44 deg C

FLEX Query
SL [send last datum]
QS [quit session, sleep]

Recovery

Keep the instrument in water until you have completed all comms. Start a log file and then
send the following commands:

STOP [stops logging]

DS [have an accurate clock handy and record the instrument's clock error]

QS

Other Commands

TSS  [take sample, store, output, power down]

STARTNOW ([start sampling immediately]

STOP  [stop logging]

DDb,e [download data samples #b through #e]

PUMPON [continuously run pump]

PUMPOFF [turn off PUMPON]

TS [take sample, output, do not store - but will output with SL command]
DC [display calibration coefficients]
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SeaBird 37IMP (Pre v3)

ALWAYS KEEP THE CONDUCTIVITY CELL WET WHEN LOGGING OR COMMUNICATING WITH THE
INSTRUMENT

The SeaBird MicroCAT (SBE-37IMP with Inductive modem, Memory, and Pump) is normally set
up to sample every ten minutes, and is queried inductively once an hour, 6 minutes after the
hour, by FLEX.

The SBE37 is run in the "Autonomous Logging" mode. In this mode, the pump will run whenever
the instrument samples and whenever any inductive command is sent. SeaBird pumps should
not be run dry, so the cell must be filled with absolutely clean water (sea or fresh), the vent
hole covered, and the cell oriented upwards if it is running or you are even talking to it
inductively to set it up.

The only way to communicate with the SBE37IMP is via a SeaBird Inductive Modem Module
(see IMM quicksheet). The first batch of SBE37s that were purchased (SN 6072-6079 and SN
6140-6146) mimic the older style IM. Therefore a "sendwakeuptone" command is needed to
talk to the instrument after it is asleep.

Standard Setup Commands
Once the IMM box is setup, start a log file in the terminal program and initiate communications
with the instrument:

FCL [capture the inductive line]
SWT [wake up the instrument]
ID? [get the instrument’s inductive address]

Program the instrument for deployment:

*ID=nn [set the inductive address to nn]

#nnDS [display status]

#nnMMDDYY=mmddyy

#nnHHMMSS=hhmmss

#nnFORMAT=1 [sets date format to 01 Jan 2008]

#nnREFPRESS=ddd [deployed pressure in decibars; 1db = 1m; do not use when pressure
sensor is present]

#nnPUMPINSTALLED=Y

H#nnINTERVAL=600 [10 minutes]

#nnSTORETIME=Y [store sample time with data]

H#nnTXSAMPLENUM=Y [flex expects the samplenumber]
#nnSAMPLENUM=0 [initialize memory]

#nnSTARTMMDDYY=mmddyy

#nnSTARTHHMMSS=hhmmss [start at an even 10min interval, e.g. 232000]
#nnSTARTLATER

#nnDS
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Sample DS Output
IMM>#45DS

<RemoteReply>SBE37-IM V 2.3b SERIAL NO. 6072 11 Sep 2010 03:53:48

not logging, waiting to start at 24 Sep 2010 03:00:00
sample interval = 600 seconds
samplenumber =0, free = 231854
store time with each sample
transmit sample number

A/D cycles to average = 4
reference pressure = 1.0 db
internal pump is installed
temperature =21.99 deg C
S></RemoteReply>

<Executed/>

FLEX Query
SL [send last datum]

QS [quit session, sleep]

Recovery

Keep the instrument in water until you are finished communicating with it. Start a log file and

send the following commands:
FCL

SWT

ID?

#nnSTOP [stop logging]

#nnDS [have an accurate clock handy and record the instrument's clock error]

#nnQS

Other Commands

TSSTx  [take sample, store, output] DO NOT USE out of water
STARTNOW ([start sampling immediately]

DDb,e [download data samples #b through #e]

PUMPON [run pump for 5 seconds] DO NOT USE out of water

TS [take sample, output, do not store] DO NOT USE out of water
DC [display calibration coefficients]
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Upgraded Doppler Volume Sampler (DVS)

The upgraded instruments now have an external comm connector, so it is no longer necessary
to open the case the use serial comms. This will be the easier and more reliable way to
program the instrument and download data. The baud rate is set at the factory to 115,200.

Following is a sample setup. The parameters will change depending on deployment, so make
sure to verify the parameters (eg. ED, EX, MN, TE, TP, WP, WN, WS, WF) needed for your
deployment. Commands are not case sensitive, except ErAsE in the ME command.

Standard Setup Instructions

To set the IM ID#:

Use the DVS-specific IM box for comms

Open the DVS software (close the wizard pop up window at startup)
Go to Configure>Serial Comms and click the check box for Use IMM
Set the baud rate to 9600

Go to Configure>Modems

Check the box for the DVS IMM

Select the Reset Modem ID radio button

Enter the desired ID#

Click the Configure Modems button

The process may take several minutes

Start a log file and use the terminal window to send the following commands:

PSO [get unit serial number for log file]
CSTATE [check current state - pinging or not]
If pinging,

CSTOP [stop pinging]
CR1 [set factory defaults]
CT0 [turn off "turnkey" mode for setup]
CK [store settings with turnkey off]

TSyymmddhhmmss [time set]
ME ErAsE [erase memory]

PA [run self tests - if using IMM, it will time out after 2 minutes, PA takes ~15 minutes]
PF [display self test results]

CF11000 [set output format to ASCII; required for flex]

EDnnnn [set depth of transducers for sound speed calculation (decimeters)]

MNXXXXXX [deployment name - use 4 or 5 digit DVS serial number (e.g. 0016)]
TFyymmddhhmmss [time of first ping - typically something like hh5900]
TE0O1000000 [ensemble repeat interval (hhmmssdd, 1/hour)]

TP000100 [time between samples (mmssdd, 1.00 seconds)

WN4 [number of bins - 1 to 5]

WP120 [number of pings]

WS100 [bin length incm ]

WF7 [blanking distance in cm; 7 starts first bin 10 cm out]
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E? [show E settings]

M? [show M settings]

T? [show T settings]

wW? [show W settings]
CT1 [turn turnkey back on]
CK [store settings]

c? [show C settings]

CS [start sampling]

Now close the log file.

Flex Query
CW [retrieve last sample]
CZ [sleep]

Recovery
Connect via the serial cable.
CSTOP [to stop logging]

CTO  [to keep it from automatically restarting]

CK [so it will remember that, in case it resets during shipping]

T? [record the clock error from the TS field]

Cz [to put it to sleep]

Download Procedure

Use the serial connector and DVS Windows software. To download data, either choose the
“Recover data from a DVS recorder” radio button in the startup wizard, or go to Tools>Recover
Recorder Data. Follow the download instructions. When download is complete, convert the
PD20 data to PDO. Name the file “DVS_SN##.pd0.”
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Doppler Volume Sampler (DVS)

The DVS are more problematic to talk to than the SBE instruments. The best communications
are via RS-232, but that means opening up the pressure case (be very careful, and use the back-
out screws to ease the case open. Do not just pull the case open, as you are very likely to break
connectors inside if you do that, which cost $1600 to replace). Then plug in the comms cable
(with or without power) to the one horizontal, 6 pin connector on the bottom-most circuit
board. | believe all PMEL DVS are set to 9600-8-N-1, but sometimes they come from the factory
set to 115,200 baud. Then you can enter the commands below.

If you are using the IMM, run the test loop through the inductive coil, and snug down two
diagonal bolts to ensure the coil is mated. Also, be sure you are using the IMM comms box
specifically configured for DVS. Sometimes there are communications problems, that mean you
can talk to the IMM fine (!Inn commands), but can't seem to communicate with the electronics
(#nn commands).

Then you will have to start dealing with DVS idiosyncracies. First, an overview:

The DVS currently requires its own line termination character, a ctrl-m, and line feed, ctrl-j. This
can be done manually, or the terminal program can be changed to automatically send CRLF. To
send an inductive command to the DVS, you need to type something like #nn? m”~m?j.

#nn sends the command to the right IMM. The IMM forward on everything between the #nn
and its line termination. So ?"m is sent to the DVS, which should reply with a list of command
choices.

The DVS can have I/0 through either the RS-232 serial cable, or the IMM. But not both. On
power up, or after a reset, or after the CS or CSTOP commands, it switches to have serial I/0. If
you want to communicate via IMM, you need to have the DVS awake, then send the IMM
command 'nnSENDBREAK”~m*j to cause the DVS to switch output to the IMM. After that is
done, all commands should work fine via IMM indefinitely, until one of the above events
triggers a return to serial comms. But the DVS must be awake before the sendbreak will work! If
it is sleeping, the sendbreak does nothing. So to be sure to switch the comms, you need to send
something like #nn? m”mAj (or, really, you don't even need to send the question mark - any
character seems to wake it up), which will wake it up if it is not (regardless of whether it is set
for serial or IMM comms - | know that's strange), then InnSENDBREAK”"m*j. Conversely, if in
IMM comms mode, and you want to talk to it via serial cable, you must send a "break"
character from your terminal emulator to reset to serial comms mode.

Commands are not case sensitive, except ErAsE in the ME command.
Following is a sample setup. The parameters will change depending on deployment, so make

sure to verify the parameters (eg. ED, EX, MN, TE, TP, WP, WN, WS, WF) needed for your
deployment.
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Standard Setup Instructions
First, start a log file.

PSO [get unit serial number for log file]
CSTATE [check current state - pinging or not]
If pinging,

CSTOP [stop pinging]
If using the IMM, it will now be out of communication again, and you'll have to InnSENDBREAK

CR1 [set factory defaults]
CT0 [turn off "turnkey" mode for setup]
CK [store settings with turnkey off]

TSyymmddhhmmss [time set]
ME ErAsE [erase memory]

PA [run self tests - if using IMM, it will time out after 2 minutes, PA takes ~15 minutes]
PF [display self test results]

CF11000 [set output format to ASCII; required for flex]

EDnnnn [set depth of transducers for sound speed calculation (decimeters)]

MNXXXXXX [deployment name - use 4 or 5 digit DVS serial number (e.g. 0016)]
TFyymmddhhmmss [time of first ping - typically something like hh5900]
TE01000000 [ensemble repeat interval (hhmmssdd, 1/hour)]

TP000100 [time between samples (mmssdd, 1.00 seconds)

WN4 [number of bins - 1 to 5]
WP120 [number of pings]
WS100 [bin length incm ]

WF7 [blanking distance in cm; 7 starts first bin 10 cm out]
E? [show E settings]

M? [show M settings]

T? [show T settings]

wW? [show W settings]

CT1 [turn turnkey back on]
CK [store settings]

c? [show C settings]

CS [start sampling]

Now close the log file.

Flex Query
CW [retrieve last sample]
CZ [sleep]

End of Deployment

If using the IMM, the following sequence will stop logging and put the DVS to sleep for serial
download later:

H#12AM~AMA) [to wake it up if not in IMM comms mode]

112sendbreak®M?”J [to switch to IMM comms if not in it already]

#12cstop*MAMAJ  [to stop logging]

112sendbreak®M?J [to get back IMM comms]
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#12CTOAMAMA)  [to keep it from automatically restarting]
#12CKAMAMA) [so it will remember that, in case it resets during shipping]
#12CZAMAMA) [to put it to sleep]

If using a serial cable, the following sequence should shut it down:
cstop™M  [to stop logging]

CTOMM  [to keep it from automatically restarting]

CKAM [so it will remember that, in case it resets during shipping]
CZMMm [to put it to sleep]

Download Procedure
Use the internal comm cable and the DVS Windows software.

Other Commands
? [menu of commands]
T? [menu of T commands, etc]
CO  [collect and display a single sample]
cw [retrieve last sample]
EBbbbdd [heading bias, 100ths of a degree; normally 000.00]
ESss [set salinity for speed of sound calculation; 35 is default and what we use]
EX11111 [default value; tilts, bin mapping on]
MM [report memory usage]
MQ  [download ASCII]
MY [download Y-modem]
PC2 [display single refreshing line of compass, temperature data]
PC20 [display scrolling lines of compass, temperature data]
PC4 [display power data]
PTnn [individual self tests]
SG 50 0 [set compass calibration to use 50 points, NO stability checking]
SCO [perform compass calibration]
SC2  [store compass calibration from SCO - do IMMEDIATELY after SCO]

Cut-and-Paste Configuration
CF11000

TE01000000

TP000100

WN4

WP120

WS100

WEF7
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